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Introduction
Included below is the following information:

•  Symtrix.ini file
•  ImageServer client setup information
•  ImageServer post-installation checklist

Symtrix.ini File
[Site Information]
SiteName=Voyager ImageServer

[Database Setup]
DatabaseName32=Auto ; do not change
DB_Connect=Auto ; do not change
UseDefaultLogin=Yes ; do not change

[Registration]
RegisterHost=xxx.xxx.xxx.xxx ; your server's IP address
RegisterPort=NNNN ; use 7500 if only one Image Server database

; use a different port for each ImageServer
database

[Message Timers]
CheckForNewMessages=1 ; specify time in minutes
PurgeExpiredMessages=5 ; specify time in minutes

[Environment]
ToolBar=-1 ; do not change

[Import Manager]
RunFrequency=6 ; do not change

[Full Text OCR]
VerifierThreshold=100 ; valid values are between 0 and 999 (See

  ImageServer Client Setup)

[Settings]
ThumbnailAllPages=NO



ImageServer for Voyager Users6

ImageServer Clients Set Up
The installation instructions for ImageServer and ImageMaintenance are as follows:

1. Before beginning the actual installation process for the new version of ImageServer,
you will need to install the latest patch for Oracle ODBC drivers version 8.0.5.0 or
8.0.5.2.  At this time the patch is 8.0.5.7.0. To install the patch, unzip the
OraPatch.zip file and follow the instructions in the accompanying “read me” file.

Note:  The previous version of ImageServer also required version 8.0.5.7.0.  This
means that if you are upgrading from ImageServer 3.5, you may not need to perform
this step.   To verify the version of the ODBC drivers that you have installed, run the
Oracle Installer from the Oracle folder.  If Oracle ODBC Driver 8.0.5.7.0 appears in
the Installed Products window, you do not need to install the drivers patch.
Otherwise you must install the patch.

2. If this is a new install (i.e., no previous version of Symtrix on the PC), skip this step
and proceed to Step 3.  This version does not include online help files, so if you want
to use your existing help and .cnt files, you must copy them to a different directory
before installing ImageServer.

Note: These help files are not Voyager-specific help files; thus, their content has not
been tailored to be Voyager-specific.   While the information is correct (as of
ImageServer 3.5), it does not supply any Voyager-specific context.  For more
Voyager-specific information, see the ImageServer manual.  (A PDF version of the
manual is included as part of the standard installation.)

3. Run the Setup.exe file  to install the ImageServer clients in your Symtrix
directory. This version does not install online help files. This install will require
approximately 90 MB of free disk space.  During installation, the setup.ini file must
be in the same folder as the setup.exe file.

Note:  By default, both ImageServer and ImageServer Maintenance will be installed.
If you do not want the ImageServer Maintenance to be installed, you must open the
setup.ini file and set the Maintenance variable to False.  Then, when the Setup.exe
file is run, only ImageServer will be installed.

4. Unzip the ImageServer_Misc.zip file. Once the file is unzipped:

a) Copy the HighBitAsciiOracle.reg file to anywhere on your hard
drive. Double-click on the file to run it. This will ensure proper Oracle
settings on your local machine. Note:  Not having these Oracle settings
will result in the Invalid Password error message when you log into
ImageServer.
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b) Copy the SymScan.ini file to your Symtrix directory.
c) Copy the Symtrix.lic file to your Symtrix directory.

d) Copy the Symtrix.ini file to your Symtrix directory and modify it as
follows:

i) Fill out the [Registration] stanza.  RegisterHost
should be set to be your IP address. RegisterPort will be
7500 but will need to be changed if your institution has
multiple Image Server databases on the same server.

ii) Do not remove the [Full Text OCR] stanza.  It is
required to perform OCR functions.

iii) Do not modify the “Auto” settings in the DatabaseName32
and DB_Connect parameters.

5. Unzip the ImageServer_Doc.zip file. This file contains the user’s manual for
ImageServer and ImageMaintenance in PDF format.

You may browse it using Acrobat Reader.

6.   If you are upgrading from 3.5 and wish to continue using those online help files, then
copy the saved .hlp and .cnt files from step 2 into the Symtrix folder.
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ImageServer Checklist
Following are PC and server settings that must be defined after the installation of the
ImageServer client to enable ImageServer’s full interaction with Voyager.  In addition,
there is a section on scanning hardware/software.

PC Settings

1. Verify the values in the symtrix.ini file (found in the symtrix folder on your PC).
The symtrix.ini that is used for Image Server version 3.8 has changed. It is
recommended that you use the symtrix.ini that comes with your installation
package.

See the sample symtrix.ini file on page 5.  Your settings should match those of the
sample file.

2. To view ImageServer links from the Cataloging client via the Record/Verify Links
function, the ImageServer Path in the Options>Preferences in Cataloging must be
set to either:

a) http://<your.host.name.here:optionalport>/cgi-bin/scandoc.cgi
   OR

b) c:\symtrix\iadms.exe

3. To send OCR data from ImageServer to Cataloging, you may override the default
MARC mapping values on the Validation tab in the Options>Preferences section
of  the Cataloging client. The default mapping is field 500 subfield "a".

4. To view ImageServer links from the Windows OPAC, the following stanza needs
       to be in the opac.ini file located in the Voyager>Opac folder:

[Image Server]
Program=<URL of scandoc.cgi>   (as in 2.a above) OR <Direct path on PC
to iadms.exe>   (as in 2.b above)

Desc=<An appropriate message that appears in the status bar when the
user's mouse is over an 856 link in the Windows OPAC>

Loadtime=20 (only needed if Program=<Direct path on PC to iadms.exe>)
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Server Settings

1. To view ImageServer links from WebVoyage, the voyager.ini file located in
/m1/voyager/xxxxdb/etc/webvoyage must contain the following information:

[Links]
ScanDoc=http://<your.host.name.here:optionalport>/cgi-bin/scandoc.cgi

Note:  It must be a fully-qualified URL (not just scandoc.cgi). If you are
running an SSL webserver, replace http with https.

[Communications]
FileServer=<proper IP address or host name of the file server machine>
FilePort=<XX70>

Scanning Hardware and Software
ImageServer supports 2 types of scanner hardware/software: 

•  The KOFAX scanner card and compatible scanner, which is primarily used for high-
speed scanning and duplex scanning.  It is very fast but semi-expensive, and only
supports images that are 1 bit per pixel (black and white). 

•  Any “twain” compatible software/hardware (e.g., scanners, digital cameras, etc.) 
Normally, most scanners and digital cameras come with image acquisition software
so that the device can import images into your PC.  This software is usually twain
compliant.  ImageServer will support all twain software by interfacing with the
software when the scan button is clicked, at which point the software will
communicate directly to the attached hardware. 

It is likely that you wilI want the twain as opposed to KOFAX solution.  Currently, when
using the twain scanning option (set by entering TWAIN_JPEG as the scanner type in
the SymScan.ini file), ImageServer scans one page per button click.  However, Image
Server has been enhanced to allow batch scanning (continuous or multi-file)
image acquisition with one click of the button.   For example, if a color scanner has
an Automatic Document Feeder (ADF) in which you can stick 20 or so documents and
then click scan once, all 20 documents will be placed into the Image Server unfiled
document window.

Note: Regardless of the hardware/software you use, for consistent and clear scanning of
OCR text, scanners must be set at 300dpi or greater.
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Chapter 1: System Maintenance

This section of the manual is divided into two parts:

     Part I describes how to setup ImageServer Maintenance, and includes the following:
•  Defining Application Requirements
•  Adding New Applications
•  Assigning Application Storage Areas
•  System Security
•  Cataloged Collections

     Part II describes the staff use of ImageServer, and includes the following:
•  Accessing Administrative Functions
•  Maintain Folders
•  Audit Reporting

Part I.  ImageServer Maintenance

Defining Application
Requirements

ImageServer comes with one defined application, “Cataloged Collections.” New
applications may be added at any time.

Note: A default application can be set by selecting Options>Default Application from
the menu in ImageServer (as opposed to ImageServer Maintenance), and clicking on
the application name to be set as the default.  The selection is stored in the database
and is associated with the user’s login. Then, when multiple applications are specified,
the default application associated with the login is in effect until it is changed via the
same menu option.
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Use the following procedures in defining a new application:

Determine a name for the application that has meaning to users.  It is recommended that
the application name has a maximum of 25 characters, since it must appear in drop-
down lists throughout the system.

1. Determine the fields that will describe each folder in the application.

2. Assign a location on the server where the images are to be stored.

3. Determine which user groups will have access to the application.  Each of those
steps is discussed in detail below.

Accessing Application Maintenance

New applications are added through the Maintenance program.

To access the Maintenance program:

1. From your desktop, double click on the ImageMaint icon. Enter your Username
and Password and press [Enter] or click on OK.

2. Select Application Setup from the Maintenance Menu.
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The Application Setup screen will open to the Setup tab as the default.

Application This is the name that will appear to staff users when they want to
work with the image files that are stored under a new application. It
should be unique so that it will not be confusing when staff users see
the application names from the drop-down list. It is recommended
that the application name have a maximum of 25 characters.
Punctuation is not allowed—spaces are allowed.

Folder Fields Each field is a type of information that is used to describe an
electronic folder.

Field Properties Each folder field needs a format defined including:

Field name – The name used in the database.  E.g., Title.

Screen name – The label used for the Field Name in ImageServer.
It is an editable field.   It may or may not be the same as the field
name.

Data type – Defines whether users will enter free-form text, a date,
or select from a drop-down list when using ImageServer.

Size – Maximum number of characters that users are allowed to
enter as free-form text for the field name when using ImageServer.

Folder Fields

Application

Document
Descriptions

Application
Settings

Drop Down
Field Items

Field Properties
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Drop-Down
Field Items

If you select drop-down list as the data type, this is where you enter
the options that will be available to users when they select folder
data from a drop-down list in ImageServer.

In the example, Language is the only field that has a drop-down list.
All other field properties in the example are text and one is date (for
the year field).

Application
Settings

Allows you to set various options relating to the application including:

Free-form document descriptions – Specifies whether Document
descriptions may be manually entered or selected from a list in
ImageServer.

Show unauthorized folders – Allows users without access rights to
see that a folder exists (but still prevents them from viewing the
contents of the folder) in ImageServer.

Active – Defines whether the images stored in the application will be
accessible to viewing by patrons in WebVoyage.

Login Required – Defines whether the patron must log in to
WebVoyage before being allowed to view images stored in this
application.

Document
Descriptions

(Optional) This is the wording of the hyperlink to the digital file
archived in the ImageServer database. Document Descriptions
provide a consistent, organized method of filing various images.
Limiting the Document Descriptions to an authorized list maintains
consistency from one folder to another and ensures reliable retrieval
in the future. For example, you can set the authorized list to begin
with image of, photo of, text of, sound clip of, video of, or any digital
object you will use with ImageServer.

If this field is left blank, a staff user will be able to enter a description
in ImageServer.

Note: Throughout ImageServer the term document is used
interchangeably with image. Both of the terms represent any form of
digital object, such as photo, text, sound clip, and video.

Adding New Applications

1. From the Application Setup screen, click on the New button. The cursor will be
automatically placed in the Application Name box at the top of the Setup tab.

2. Enter the name you want to give the new Application.
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3. Click on the New button in the Field Properties area. The cursor will
automatically move to the Field name box under Field Properties.

As you type the field name, the system automatically enters the same name for
the Screen name that users will see in ImageServer. The Screen name field is
editable if you want to rename it.

Note: Since blank spaces are not permitted, underscored lines will appear each
time you use the Space Bar. Press [Tab] or [Enter] to move the cursor to the
next box.

Note:  You can also use this field to circumvent naming restrictions dictated by
Oracle.  For example, “date” is an Oracle data type; because of this, Oracle
prevents you from using “date” as a field name.  However, you may set the field
name to be “A_Date” or “The_Date” and enter “Date” as the screen name.  Since
the screen name appears in Image Server and not the field name, the user will
see “Date” and not “The_Date.”

4. For Data type, select Text or Drop Down List. Press [Tab] or [Enter] after your
selection is made. Descriptions of the data types are listed below. It is
recommended that staff using Voyager limit use of data types to text and drop-
down list.

Data Type Description
Text Free-form text in alpha or numeric. Recommended for names

and dates. Data entered is left-anchored index.

Drop Down List In ImageServer, Voyager users will select an entry from a
drop-down list created on this tab.  Recommended if you want
to limit your users to a specific set of data types.  Note:  This
list is already present in the database for the default Cataloged
Collections application.

In the Size box, enter the length of the data field. Following are some examples:

•  75 for Title
•  50 for author name
•  75 for publisher
•  4 for date

5. Free-Form Data Entry Check Box is active only if you selected Drop Down List
for the data type. Select the Free-form data entry option if you want the
ImageServer users to have both options — to select from the drop-down list or
manually enter data in a field.
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6. If you selected Drop Down List for the data type, you must enter the choices
users will have when using ImageServer. For example, if the field name were
language you would enter the languages that you want to appear in the list.

a. Click the Add button in the Drop Down Field Items block to begin adding
field names.

b. Enter the name of the field in the entry field below the Drop Down Field
Items list.

c. Click the Save button in the Drop Down Field Items block to add it to the
list.

You can also edit a field item by highlighting it in the list and then clicking the
Edit button.  When the field item appears in the entry field below the list, change
the item and click the Save button.
You can remove a field name by highlighting it and clicking the Remove button.

7. Click on Save (the one that appears in the Field Properties frame) to save the
field properties. The Field name will be listed under Folder Fields on the left side
of the Application Setup screen.

8. To add additional folder fields, click on the New button and repeat Steps 2
through 8.

9. If a field is entered out of sequence, select it from Folder Fields list and click on
Up or Down button to change the display order.

Following is an example of a finished set of Folder Fields and what their “screen
names” would look like in ImageServer.
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10. In the Document Descriptions area add a list of items that will limit the Document
Descriptions to an authorized list.

a. Click the Add button in the Document Descriptions block to begin adding the
document name.

b. Enter the name of the document in the entry field below the Document
Descriptions list.

c. Click the Save button in the Document Descriptions block to add it to the list.

You can also edit a document name by highlighting it in the list and then clicking
the Edit button.  When the document name appears in the entry field below the
list, change the name and click the Save button.
You can remove a document name by highlighting it and clicking the Remove
button.
Note:  The workflow checkbox is not used with Voyager.

Application Settings

The following four options are available under the Application Settings area on the
Application Setup screen:

Screen Names
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•  Free-form document descriptions - This allows a user to manually enter a Document
description by typing the name in the box rather than being required to select one
from the drop-down list when adding documents to folders in ImageServer.

•  Show unauthorized folders - This gives a user who does not have access to
unauthorized folders the ability to see that the folder exists In ImageServer.  When
this option is selected, the folder data will appear in the Folder Searches and be
available for display to anyone in ImageServer.  However, the user will not be able to
open the folder to see the contents or to delete the folder unless they are an
authorized user.
Note:  This checkbox pertains only to controlling access to the application in
ImageServer.  This does not affect access to the application in WebVoyage.

•  Active – This specifies whether the images in this application will be available for
users to view in WebVoyage.  When this checkbox is turned off, the contents of this
application will not display in WebVoyage.
Note:  This checkbox pertains only to controlling access to the application in
WebVoyage. This does not affect access to the application in ImageServer.

•  Login Required – This specifies whether a user must be logged into WebVoyage
before they can view the images in this application.  If this is turned on, the user must
have a valid WebVoyage login to view these images.  A “valid” login is any
WebVoyage login.  This means that anyone who has a current WebVoyage login will
be able to view all of the images stored in applications that have the Active
checkbox turned on.
Note:  This checkbox pertains only to controlling access to the application in
WebVoyage. This does not affect access to the application in ImageServer.

Controlling Access to Images Displayed in WebVoyage
The Active and Login Required checkboxes determine how the images in an
application can be accessed when searching the database in WebVoyage.

•  If you do not want the images in the application to be available to patrons
searching WebVoyage, turn off the Active checkbox (no check).   When the
Active checkbox is turned off, the Login Required checkbox is irrelevant.
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•  If you want to make the images in the application available to anyone searching
in WebVoyage, turn on the Active checkbox (a check) but turn off the Login
Required checkbox.

•  If you want to make the images available in WebVoyage to anyone with a valid
login, turn on both the Active and Login Required checkboxes.

After the application, folder fields, document descriptions and application settings have
been established, click on the Save button at the bottom of the page. A confirmation
message will appear to remind you of the next step: to assign group authorizations at the
Security screen and to assign a storage area for images at the Document Storage
screen.
Note:  Clicking the Save button will cause the new application to disappear from the
Application drop-down list.  This is not a bug.  The new application still exists but will
not appear in the Application Setup dialog until you have assigned authorizations on the
Security screen.

Click the Close button to close the Application Setup screen.  Before you can finish
setting up the application, you must add the new application to the list of authorized
applications in the System Security Setup screen.

System Security Setup Screen

The System Security Setup screen specifies what types of access are to be made
available to operators within either ImageServer or ImageServer Maintenance.  This
description is only intended to allow you to make a new application accessible so that it
can be further defined.  System Security is discussed in full on page 27.

To make a new application accessible:

1. From the Maintenance menu, click the System Security button.  This opens the
System Security Setup screen

2. On the System Security Setup screen, click the Authorize tab.

3. Highlight the Group Name of the group of which your current login is a member and
click the Edit button.  This allows that group to be edited.

4. Highlight the name of the new application where it appears in the All System
Applications list and click the Add button.  This will allow members of that group
access to the new application.
Note:  Make sure that the group to which you add your application is authorized to
use System Maintenance (i.e., by having the Can use System Maintenance
checkbox turned on).

5. Click the Save button.  This saves the edits made to the group authorizations.

6. Click the Close button to close the System Security Setup screen.
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Indexes/Sorting Tab

After each application has been set up and authorized, click the Application Setup
button again.  The new application should now appear in the Application drop-down list.
Select the new application in the Application list and click on  the Indexes/Sorting tab.
Click on the Edit button to activate the screen.

When the screen is active, the Edit button is replaced by the Save and Close buttons.

•  Setup Application Indexes - For each application, it is suggested that you select
the primary fields that will be used most frequently when retrieving folders. Make
your selections by clicking the box to the right of the Field Name. A red check
mark will be placed after your selection has been made.

•  Setup Application Sorting - For each application, you can select up to three fields
that will determine the order the folders will be listed when a search is done.
Make your selection from the items in the drop-down list. Click on Save button to
save your settings and then Close to exit the Application Setup screen.
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Fields Mapping Tab

After each application has been set up, go to the Fields Mapping tab. Click on the Edit
button to activate the screen.

The Fields Mapping tab is where you will assign the MARC values to the fields in an
application. Use this option to define individual tags, indicators, and subfields. The
values will transfer to the MARC bibliographic record when sending the information from
the Image Server client to the Voyager Cataloging client.

To assign the MARC Mappings:

1. Select the Application from the drop-down list. Click on Add mapping to
application button. The cursor will be placed in the Tag field under the MARC
Mapping area.

2. Enter the MARC Mapping data for each index field as it will appear in the folder
name.

3. Click on Save after all the data has been entered.

4. Click on Edit to make changes to the MARC Mappings.

5. Remove mapping from application will clear all mapping for the selected
application, making communication with Voyager impossible until new mapping is
assigned.
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MARC Mapping Sequence

The Sequence field in MARC Mapping offers some versatility for sending tags to
Voyager Cataloging. The variations are described below.

Group subfields into a single tag – Offers the flexibility of arranging more than
one subfield in a single tag. Note tag 260 and its subfield assignments below.

Sort tags – Offers control over the order that tags can be sent to a new
bibliographic record in Voyager Cataloging. Note tags 245 and 100.  If you want
Author to come before Title, assign Author sequence 1 and Title sequence 2.
The order of appearance in the bibliographic record in Voyager Cataloging is
based on the assigned sequence numbers.
Note:  The order of appearance of the fields in the folders in the ImageServer
client is not affected by the sequence numbering.

The MARC Mapping fields may be edited at any time.  When editing these fields, you
must click the Save button after changing each field.  If you do not click the Save button
before you highlight another field, the changes made to the previous field will not be
preserved.  Clicking Save after editing each field will prevent your edits from being lost.

Field Name Tag Sequence Indicator 1 Indicator 2 Subfield

Title 245 2 0 0 ‡a

Author 100 1 1 ‡a

Edition 250 3 ‡a

Publisher 260 4 ‡b

Place 260 4 ‡a

Year 260 4 ‡c

Collection_Title 440 5 0 ‡a

Language 008 6 ‡36

Subject 650 7 4 ‡a
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Assigning Application Storage
Areas

Each application must have adequate storage space on the server. ImageServer
automatically stores the files in subdirectories that correspond to the date that the
images were added to the ImageServer database. For example, files are stored in
/m1/voyager/isxxxdb/images/ by reverse date, i.e., 991029, the date the file is added.
The Document Storage function in ImageServer Maintenance program controls the
storage areas for new images.

The next step of the setup process for a new application is the configuration of the
directories where all the files will be stored. In ImageServer, image files will be stored on
a server.  Assigning a storage location to a new application or changing the active area
for an existing application is done from the Document Storage screen that can be
accessed from the Maintenance Menu.

The Document Storage function allows the system administrator to select the machine
and directories that will be used for each application.

The Document Store specifies the IP address of the machine where the images are
storeed.  The port is the one that corresponds to your ImageServer server (iasock)  and
your ImageServer database.

Note:  During ImageServer installation, a default document store entry is added to your
ImageServer database.  You must edit the IP, port and directory added so that the
information matches your institution’s current ImageServer setup.
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To assign a storage location:

1. Specify the new storage directory on the file server by clicking on the Document
Storage button at the Maintenance Main menu.

2. To assign a new application storage, click on New button on the lower portion of
the Document Store Assignments.

3. Enter a description in the Description field.

4. Enter an application in the  Application field.

5. Enter the correct storage path in the Path field.   For new installations, the path
must be modified to match your directory structure.

6. The # Docs is system-generated each time a new image is stored.

7. Click the Active? box.

8. With the exceptions of authorizing staff users and defining MARC mapping, the
new application is now ready to have images filed into its electronic folders.

Note:  Only one path is allowed for each application.  Once a path has been associated
with an application, all images stored in that application are stored in that path.  Because
of this, we do not recommend that you change the path.
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Maintaining Applications

Once your applications have been established, modifications can be made to the current
settings by using the Edit function at the bottom of the Application Setup screen.

Changes you can make include: Changes you cannot make

Edit Application Name
Add Folder Field
Add, Edit, Remove Document Name

Modify or Remove Existing Folder
Fields

To change a document description:

1. At the Application Setup screen, click on the Edit button. This will activate the
Document Descriptions functions.

2. Select the name of the image that you want to change from the list of Document
Descriptions and click on the Edit button.

3. The cursor will be automatically placed in the textbox that is just below the
Document Descriptions list. Enter the new image name and click on Save button.
The new image name will be added to the Document Descriptions list.

To delete a document description:

1. Select the name of the image you want to delete from the Document Descriptions
list.

2. Click on the Remove button. Note: Once you click on the Remove button the
image name is deleted. There is no confirmation message or cancel option. If the
image name was deleted in error, you can add it back to the list by using the Add
function.

Deleting Applications

Applications can be deleted when they are no longer needed or when they have been
setup incorrectly.

WARNING: A high level of caution must be used when deleting an application since it
will permanently remove and destroy an entire set of electronic folders. Due to the
severity of this delete function, the staff user is prompted twice to confirm the action.
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To delete an application:

1. At the Application Setup screen, select the Application you want to delete from
the drop-down list at the top.

2. Click on Remove button. The Delete Application confirmation box will appear
with a Warning message.

WARNING: Please read the warning message since deleting the application will
permanently remove it from ImageServer. All data associated with the application
will also be permanently deleted.

3. To delete the application, click on Yes. (No is the default.) A second Delete
Application confirmation box will appear.

WARNING: Please read the message in the confirmation box since deleting the
application will permanently remove it from ImageServer. All data associated with
the application will also be permanently deleted.

4. To delete the application, click on Yes. (No is the default.) The application is
permanently deleted.

Note: The image files stored in their assigned storage area are not deleted, but
all information required to access them has been deleted — links to accessing
them have been severed.  If any of the images were added to bibliographic
records in Voyager (by adding 856 links to the images), those links are now
invalid and should themselves be removed using the Cataloging module.
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System Security Setup
To access the System Security Setup screen, select Security from the Maintenance
menu.

There are three steps to establishing users and security at the System Security Setup
screen:

1. Defining Individual Staff Users (Users Tab)

2. Creating Staff User Groups (Groups Tab)

3. Assigning Access Authorization to Staff Groups (Authorize Tab). This involves
access control for users and folders, and requires you to set access levels in the
ImageServer module as well.

Defining Staff Users
The first step in establishing System security is to define the individual staff users who
will have access to the system. This is done at the Users tab from the System Security
Setup screen. From the Users screen, you will be able to perform the following
functions:  Add a Staff User, Modify Staff User Information, Delete a Staff User.
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To add a new staff user:

1. From the Users screen of System Security Setup, click on New button. The
cursor is automatically placed in the Name box under User Profile Properties.
Enter the staff user’s name as it will appear throughout the system. (Maximum
number of characters allowed is 20.) Press [Tab] or [Enter] to go to the next
textbox.

2. Enter the staff user’s password. (Maximum number of characters allowed is 20.)
For security reasons, the password will be represented by a series of asterisks
(*). Press [Tab] or [Enter] to go to the Description textbox. The Last Modified
field is automatically entered with the current date and time.

3. Enter a description for the staff user. This is generally the staff user’s job title or
function within an organization. (Maximum number of characters allowed is 100.)

4. The Menus On option in ImageServer gives staff users access to the main
menus when they log on to ImageServer. The box is checked (turned on) by
default.

5. From the User Activity list select the functions you want to be able to audit for
that user. Click in the audit box to the left of the User Activity to select a function.
Use the scroll bar to access all the listed activities.
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6. Click on Save button to save the User Profile Properties. The staff user will be
added to the User Name list on the left side of the screen.

To modify staff user profile information:

1. At the Users screen, make your selection from the User Name list on the left
side of the screen.

2. Click on the Edit button. The User Profile Properties section will become active.

3. Double click on the field you want to modify and enter the new information. Click
on Save button to save the changes.

To delete a staff user:

1. At the Users screen, make your selection from the User Name list on the left
side of the screen.

2. Click on the Remove button. A confirmation message appears. Click on Yes to
permanently remove the staff user from the system. (No is the default.)

3. A second confirmation message appears. Click on Yes to deactivate the staff
user. (No is the default.) If the staff user is currently logged into the system,
he/she will be able to continue working. After the staff user exits the system,
entry back into the system will be denied.

Creating Staff User Groups

Once staff users have been set up, the next step is to assign them to a Staff User Group
at the Groups screen. Each staff user group should contain the staff users who require
access to the same applications and to the same ImageServer features and functions.
Authorization to applications and ImageServer functions is assigned at the group level.
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Note:  Staff users must be assigned to only one group.  Do not assign users to more
than one group.

To establish a staff user group:

1. From the Groups screen at System Security Setup window, click on the New
button. The cursor is automatically placed in the Name box under Group
Properties.

2. Enter the name you want to give the staff user group. Press [Tab] or [Enter] to
go to the next textbox. Enter a description or definition of the staff user group you
are establishing, then press [Tab] or [Enter].

3. The Last Modified box will be automatically filled in with the current date and
time. Press [Tab] or [Enter] to go Access Level drop-down list. Select the
appropriate Access Level for the staff user group from the drop-down list. The
options are described below.

Note:  At least one group must have the Read-Only? Checkbox unchecked.
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Access Level Description
View in Browser

Used For

Public Allows Voyager OPAC users to access the image
in view only mode by clicking on the hyperlink.
Web Voyage views the image using a browser.

Public

View Only Staff users have ability to retrieve and view
images.

Staff

View & File Staff users have ability to file, index, and retrieve
images and folders.

Staff

Administration Staff users have access to administrative
functions.

Staff

Select the appropriate Options for each staff user group.

•  Can use System Maintenance gives the staff users the right to view and
modify any of the settings in Maintenance.

•  Read Only gives staff users the right to only view the settings in
Maintenance.

•  Can change Password allows staff users to change their individual
passwords.

WARNING: Never allow staff users the option to change their password.

4. After the Group Properties have been entered, the next step is to assign users to
the group. Select the staff user from the list on the lower right side of the screen.
Holding down the Ctrl key and clicking on the staff user names can select
multiple staff users. Click on Add button to add selected staff users to the group.

5. Click on Save button to save the group and staff user setting.
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To delete a staff user group:

1. At the Groups screen, select the group name that you want to delete. Click on
the Remove button.

2. A warning message appears. Click on Yes to continue with the deletion. (No is
default.)

3. A second confirmation message appears. Click on Yes to permanently delete the
staff user group. (No is default.)

4. Click on Close to exit the System Security Setup.

Access Authorization and Control

The third and final step of defining your system staff users and security is to authorize
groups to access applications and then to set access levels for groups and folders.

To authorize staff user groups to applications:

1. From the Authorize tab of ImageMaintenance’s System Security Setup function,
select the staff user group from the Group Name list. Click on the Edit button.

2. From the All System Applications list, select the application to which you want
the group to be given access. Click on the Add button.

3. Under the Group Permissions section, select the User Activity functions for the
User Group. The Quick Authorize buttons will expedite making selections. A red
check mark will be placed in checkboxes in the Allow column next to the User
Activity.

4. Click Save to apply your edits, or Cancel not to.

Access Levels for Applications and Groups in ImageMaintenance

Access control in the ImageServer client is available at the folder level; depending on
how you set up your documents, it becomes a tool for controlling access at the
document level as well.
The implication of folder access levels is that all users in a particular group are assigned
access level rights of x (where x = the access level), when dealing with images coming
from an application. That means that if you are in a particular group, you will be able
to view all the images with an access level of x or less. You will not be able to view those
images with an access level x or more.
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To edit folder access levels for groups and applications in ImageMaintenance:

1. From the Authorize tab of ImageMaintenance’s System Security function, select
a group and an application, and click Edit.

2. Set the folder access level (from 1 to 100) by using the up and down arrows to
increase and decrease the number. Note: The default folder access level setting
is 50.

3. Click Save to apply your edits, or Cancel not to.

WARNING: It is recommended that you leave the security level in ImageMaintenance at
its default value of 50. To set security higher for certain folders while still keeping the
folder access level at 50 in ImageMaintenance, please read the next section.

Access Levels for Folders in ImageServer

After you assign access levels to applications and groups in ImageMaintenance,
you can implement viewing restrictions by manipulating the access level requirements
for specific folders in the ImageServer module. ImageServer provides security to
confidential and sensitive folders by giving an access authorization level for each folder
within an application. Secure folders will require a high access level. To increase the
level of security, increase the access number. Since users cannot view a folder with an
access level higher than their authority, the access level for users and applications (set
in ImageMaintenance) must be set to at least the same level as the folder.

Essentially, access levels in both ImageMaintenance and ImageServer work like tokens.
If you have 50 tokens in ImageMaintenance but need 75 tokens to view a document in
ImageServer, you will not be able to view the document. However, if you have 50 tokens
in ImageMaintenance and only need 45 tokens to view a document in ImageServer, you
will be able to view the image.

Therefore, ImageMaintenance folder access levels= how much access you have as
a user to view folders; ImageServer folder access levels= how much access you
need as a user to view folders.

Note: The rules that manage the viewing capablities of folders apply only to viewing of
images inside the ImageServer client.  This has no effect on viewing images in
WebVoyage.

Restricted Collections Only: For access to restricted images, it might be
helpful to

set up a separate application with a higher folder access level (e.g., 75) in ImageServer.
That way restricted images are grouped together, you know where they are, and you
understand there is only limited access through the ImageServer application.  This
restriction has no effect on viewing images in WebVoyage.  Viewing instructions for
WebVoyage are discussed in the section Application Settings.
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To edit folder access levels in ImageServer:

1. Select a folder. You can do so from any screen that allows you to get a folder
(the most commonly used screen is the one where you create a folder and its
images to send to Cataloging).

2. Once the folder is retrieved, click Edit>Folder Access Level on the main menu.
The Edit Folder Access Level dialog box appears.

3. Lower or increase the access level for that folder (from 1 to 100) by using the up
and down arrows. Note: The default folder access level setting is 50.

4. Click OK to apply your edits, or Cancel not to.

RECOMMENDATION: It is our recommendation that you leave the folder access level to
the default of 50 in ImageMaintenance, and modify the folder access level in
ImageServer. This way you can avoid potential confusion caused by setting values in
both modules.

Quick Authorize

Quick Authorize buttons can be used to add standard functionality to group
authorizations.
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The four Quick Authorize buttons and their related functions are:

Button Function
View Open Folders

View Images
Print Images
Fax Images
Export Images
Send
Folders/Images

Edit Annotate Images
Edit Folder Notes
Edit Image Notes

File File Images
Unfile Images
Delete Images
Add Folders
Edit Folder Data
Edit Folder Access
Levels
Remove Unfiled
Images
Add/Import Images
OCR Prepare
Maintain Folder
Information

Administration Delete Folders
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Part II.  ImageServer

Part II includes the following system administrative sections:

•  Maintain Folders
•  Find Folders
•  Audit Reporting

Accessing Administrative
Functions

1. From your Windows desktop, double-click on the ImageServer icon. Enter your
Username and press [ENTER] or [TAB]. Enter your Password and press
[ENTER] or click on OK. The main ImageServer window opens. If you have the
Menu On option selected on the Users tab in the Security Set up in ImageServer
Maintenance, the Administrator Main Menu will appear. Click on the
Administrator button to access the Administrative functions.

The following options are available from the Administration Menu:

•  Maintain Folders
•  Find Folders
•  Audit Reporting
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Maintain Folders and Find Folders are also available from the Folder menu at the main
window. Audit Reporting is also available from the Tools menu at the main window.
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Maintain Folders

The folder maintenance function allows you to modify indexing and filing information for
folders or images. The maintenance feature can be used in a variety of ways:

•  Editing of folder indexes, such as make a name change or correct errors
•  Deleting folders and images
•  Moving pages within a multi-page image
•  Copying and moving images to other folders

To access Folder Maintenance:

Search for the folder that you want to modify. Click on Folder menu at the main screen
and select Maintain Folders. If you are using the Administration Menu, select Maintain
Folders button.

At the Folder Maintenance screen, the index data and folder contents are shown on the
left side.



ImageServer for Voyager Users40

To edit folder index data:

1. From the Folder Maintenance screen, click on the Edit button. The data in the
first index field becomes highlighted. Type in the new data or press [Tab] or
[Enter] to go to the field you want to edit. Click on OK when all the changes have
been made.

2. To make changes on another folder, click on Existing button to search for the
folder.

3. Select the application from the drop-down list you want to search. Enter your
search criteria and click on OK.

4. Select the folder you want to modify from the Folder List and double click on it.
To modify the folder index, click on Edit. To delete the folder and its contents,
click on Delete.

5. Click on Close button to exit from the Folder Maintenance screen.

To delete a folder:

1. Search for the folder you want to delete.

2. Click on Folder menu at the main screen and select Maintain Folders. If you are
using the Administration Menu, select Maintain Folders button.

3. From the Folder Maintenance screen, click on the Delete button. The
confirmation message will appear. Click on Yes to delete the folder.

NOTE: The folder and contents of the folder will be permanently deleted from
ImageServer. Access to the folder and its contents of images will be severed.

4. Click on Close to exit the Folder Maintenance screen.

To view Images:

The contents of the folder appear under the Documents List. Images are listed
alphabetically by name. To determine the number of pages of the image, click on the
plus symbol (+) located on the left of the image name. The plus symbol will change to a
minus symbol (-) when the page details are displayed.

To view an image, select it from the Document List and click on the View button.
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To delete an image in a folder:

1. Search for the folder that contains the image file or file with multiple images in
one 856 tag that you want to delete.

2. Click on Folder menu at the main ImageServer screen and select Maintain
Folders. If you are using the Administration Menu, select Maintain Folders
button.

3. Select the image file or file of multiple images in one 856 tag from the list from
the Folder Maintenance screen, click on the Delete button. To delete multiple
856 tags, select and delete one tag at a time.

4. The confirmation message will appear. Click on Yes to delete the image. NOTE:
The image will be permanently deleted from the system. Click on Close to exit
the Folder Maintenance screen.

To move an image file within one 856 tag of multiple image files:

1. At the Folder Maintenance screen, select the page that you want to move from
the Documents List.

2. Click on the Up or Down button to move the page up or down in the sequence.

To move an image file to other folders:

1. Select the application you want to search from the drop-down list. Click on
Existing button and enter the search criteria to locate the folder that contains the
image you want to move using the left side of the Folder Maintenance screen.
This will be the source folder.

2. On the right side of the Folder Maintenance screen, select the application you
want to search from the drop-down list. Click on Existing button and enter the
search criteria to locate the folder in which you want the image placed using the
left side of the Folder Maintenance screen. This will be the destination folder. To
create a new folder in which to place the image, lick on New button and enter the
folder name.
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3. From the source folder (on the left side), select the image you want to move.
Click on Move button.

4. The Confirm Move message will appear. Click on Yes. The image will be moved
from the source folder to the destination folder.

To copy an image file to another folder:

1. Select the application you want to search from the drop-down list. Click on
Existing button and enter the search criteria to locate the folder that contains the
image you want to copy using the left side of the Folder Maintenance screen.
This will be the source folder.

2. On the right side of the Folder Maintenance screen, select the application you
want to search from the drop-down list. Click on Existing button and enter the
search criteria to locate the folder in which you want the image placed using the
left side of the Folder Maintenance screen. This will be the destination folder. To
create a new folder in which to place the image, click on New button and enter
the folder name.

3. From the source folder (on the left side), select the image you want to copy. Click
on Copy button.

4. The Confirm Copy message will appear. Click on Yes.

5. You will be asked if you want to also copy the image notes, if they exist. Click
Yes or No. The image will be copied to the destination folder.

Source Folder
Contents

Destination Folder
Contents
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To change an image filename:

1. From the Folder Maintenance screen, select the application you want to search
from the drop-down list.

2. From the Document List, select the image that you want to rename. Click on the
Rename button.

3. Select a new name from the drop-down list. If authorized, you may also enter a
free-form name for the image. Click on OK or press [Enter].
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Find Folders - Advanced Folder
Searches - Use for Quality Control

In addition to searching for folders by their indexing information, ImageServer allows you
to search for folders by their contents or missing images. In certain situations, this
powerful image search can be used to quickly locate folders by image name instead of
index information. This advance level search is available using the Find Folders option
from the Folder menu.

The Find Folders function allows you to search a user-defined subset of folders within an
application that is based on specific search criteria. For example, you could search the
ImageServer for images viewed more than four times.

To use the Find Folder function:

1. Select the Find Folders options from the Folder menu. You may also click on
the Search Folders Document button on the toolbar.

2. Select the application from the top of the Folder/Document Search screen.

3. In the Folder Selection area, select the appropriate Folder Field and Search Type
from the drop-down lists.

4. UnderCondition 1, enter your search criteria. If searching for a Range, enter the
second search criteria under Condition 2. Continue to enter additional search
information in the additional grid boxes, if necessary.

5. In the Document Selection area, select the appropriate Document Field and
Search Type from the drop-down lists. Under Condition 1, enter your search
criteria. If searching for a Range, enter the second search criteria under
Condition 2.

6. Select Show Folders to search the entire folder or Show Documents to find a
specific document.
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7. Click on Save Query or Save Query As to save the search criteria for use in the
future. All saved items can be accessed from the Open Query drop-down list.

8. Click OK to run the search or Clear to start over. If you selected Display Folders,
you will see a Browse List of folders that meet your search criteria. Display
Document will return a Documents List of all images that meet your search
criteria.
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Audit Reporting
ImageServer keeps track of a variety of statistics about the system. The following
information is tracked for each folder and image:

•  Time Last Accessed
•  Number of Times Viewed
•  Number of Times Printed
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Chapter 2: Voyager Interface
ImageServer interfaces to the Voyager Integrated Library System in the following two
areas:

•  Cataloging
•  Viewing Images

Images that are managed by ImageServer can be automatically catalogued into either
an existing bibliographic or holdings record, or into a new bibliographic or holdings
record in the Voyager Cataloging module. Images that are cataloged in this manner in
the Voyager Cataloging module may then be viewed from Voyager running either
ImageServer or your browser.

ImageServer Integration with
Cataloging

Before a new application can be used with Voyager, the following steps must be
completed. All steps are discussed in ImageServer Maintenance.

1. Define the application.

2. Set security for the application.

3. Assign document storage for the application.

4. Define MARC mapping

All integration with the Voyager Cataloging Module must be done from the ImageServer
File Documents screen. The integration adds the necessary ImageServer related
information such as application number, folder number, and image number to the MARC
record, 856 tag. You can select which of the two sets of data are sent to Cataloging.

The data sets are:
•  856 tag information for selected images or all images from a folder.
•  bibliographic information as well as the 856 tag information for selected

images or all images from a folder.
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Keyboard Shortcuts
The 856 interface to the Cataloging module is designed to work with the following
function keys.

Key Description
F8 Creates an 856 tag(s) in an open bibliographic record in Cataloging for

selected document(s).

F9 Creates 856 tags in an open bibliographic record in Cataloging for all
documents.

Alt-F8 Creates new bibliographic record in Cataloging for the values in Folder Name
and creates 856 tag(s) for selected document(s).

Alt-F9 Creates a new bibliographic record in Cataloging for the values in Folder Name
and  creates 856 tags for all the documents in the folder.
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How to send selected document(s) to an existing bibliographic record:

1. Click on Existing button then enter the criteria to locate the appropriate folder.

2. Select the document(s) from the Document List that you want to add to an
existing bibliographic record in Cataloging. One 856 tag will be added to the
bibliographic record for each selected document(s). Click on Send Cataloging
button or Press F8.

Note: The document(s) must be filed into a folder and the document(s) must be
highlighted in the Document List.

Two 856 tags are added to the open bibliographic record in Cataloging, because
only two were selected.

Note: In the same way, 856 tags can also be added to existing holdings records.
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Following is a description of the subfield data for the 856 tag.

Indicator Description

856 Tag

7 First indicator

_ Second indicator is a space

‡2 Fixed value

Sdc Fixed value

‡f Fixed value

1 Application

449 Folder

1 Image

‡z Value in document from document description
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How to send all documents to open bibliographic record:

To send all the documents in the active folder to Cataloging, check the All Docs box
then click on Send Cataloging. You can also press F9.

All 856 tags are added to the open bibliographic record in Cataloging.
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How to create a new bibliographic record for selected document(s):

1. Click the New Bib box and click on Send Cataloging button to create a new
bibliographic record for a selected document(s) in a folder. You can also press
Alt-F8.
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One 856 tag is added to a new bibliographic record in Cataloging, because only
one was selected.

How to send all documents to a new bibliographic record:

To send all the documents in the active folder to a new bibliographic record in
Cataloging, check the New Bib and All Docs boxes then click on Send Cataloging
button. You can also press Alt-F9.
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All 856 tags are added to a new bibliographic record in Cataloging:
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Chapter 3: Full-Text OCR
OCR (Optical Character Recognition) is the process of converting a scanned document
into machine-readable text. By transferring this text into a bibliographic record in
Cataloging, the text can then be searched in Voyager.  In ImageServer, you will be able
to select a specific area or full page of a document to go through the OCR process.

Note: For consistent and clear scanning of OCR text, scanners must be set to 300dpi or
greater.  See the “Scanning Hardware and Software” section of the “ImageServer Check
List” (on page 9) for more information about scanning.

To start the OCR process:

1. Open Voyager Cataloging and a bibliographic record. Specify the Tag, Indicator
1, Indicator 2 and Subfield where OCR data should be inserted into an active
bibliographic record. If you do not specify this information, the following defaults
will be used: Tag: 500, Indicator 1: none, Indicator 2: none, Subfield: a. To
change these values in Cataloging, select Options>Preferences>Mapping.

2. Minimize the Voyager Cataloging window.

3. Open ImageServer.

4. On the ImageServer toolbar click on the File Documents button.
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5. Select the appropriate application from the Applications drop-down list on the left
if it is not already selected.

6. Select the image from a folder, a list of unfiled documents, or the directory from
your disk drive.

Application
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7. Double-click on the image to view it or click the View button. The image will
appear on the left side of the screen.

8. Click anywhere on the document to activate the window.

9. On the toolbar use the Zoom In button to enlarge the view on screen, if
necessary. Each click will increase the view. You can also select the View menu
and Zoom.

10. You can select a portion of the text or the entire page for OCR. To select the
entire page, click on Recognize Page. To select an area on the page, click on
the Select Text button. The mouse indicator becomes a selection tool (black
cross). Depress the mouse button and drag over the area on the image that you
want. This will create a rectangle around the selection.

11. Click on Recognize Text button to start the OCR process.

Select Text
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Text Verification

Certain documents may have characteristics that can cause reduced character
recognition accuracy. Examples are:

•  Documents that are too dark or too light
•  Documents with thin or ornate font styles
•  Multiple-generation photocopies
•  Documents with symbols, such as $, %, & *,@, " !
•  Low resolution images, such as faxes

In this case, a Verify box will show you which text is not recognizable. The large white
area of the box will show the word in question in red. In the text box, you will see how
ImageServer interpreted the characters. You may accept ImageServer's interpretation of
the word, or edit and then accept it by clicking on Accept Word. You can adjust the
verifier threshold in the Sysmtrix.ini file, [Full Text OCR] stanza. Valid values are
from 0 to 999. The verifier threshold Lower numbers are more forgiving. Higher numbers
will check for errors more closely.

Editable Text
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Button Description

Accept Word Accepts all occurrences of the word.

Accept Word ( No Training) Accepts the word, but asks for verification if it is
encountered again.

Undo Undo last step only (either before or after pressing Accept
Word).

Accept All Accepts all text in the OCR area as is and opens Full Text
OCR Verification Results.

Cancel Closes Verify box and returns to the text area.

When the OCR process is complete, the Full Text OCR Verification Results box opens.
You may review the text in its entirety before sending it to an active bibliographic record
in Voyager Cataloging.

12. Check on Add To Bib to add to Voyager Cataloging.

MARC Mapping for OCR text

This feature is used specifically in conjunction with ImageServer. It applies to the
sending of Full-Text OCR data (text read from a non-searchable image stored in
ImageServer) from the ImageServer program to an active bibliographic record in
Cataloging. Once the OCR data is inserted into an active bibliographic record, it can be
used in keyword searches in Voyager Cataloging.

If you have not already done so, specify the MARC tag information: Tag, Indicator 1,
Indicator 2 and Subfield where OCR data should be inserted into an active
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bibliographic record. The default MARC tag for storing the OCR text is Tag: 500,
Indicator 1: none, Indicator 2: none, Subfield: a. To change these values in Voyager
Cataloging, select the Options menu, Preferences, and the Mapping tab.

Note: A maximum of 1200 characters will fit into a single field of a MARC record. Each
time a field reaches this limit, another identical field will be created into which the rest of
the data will be inserted. In addition, it should be noted that the maximum record size for
a MARC record in Voyager is 64K.
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Index
The following typographical convention is used throughout this index: Arial Narrow
typeface denotes the name of a specific button, option, screen, or tab.   

A

Access authorization and control
assigning, 32-34

Accessing
administrative functions, 37-38
application maintenance, 12-14

Adding
new applications, 14-17
new staff users, 28-29

Administration, system
 See System maintenance and

administration
Administrative functions

 See also System maintenance and
administration

accessing, 37-38
Applications

accessing maintenance, 12-14
adding new, 14-17
assigning storage areas, 23-26
authorizing staff user groups to, 32
defining requirements, 11-22
deleting, 25-26
maintaining, 25
names for, 12
settings screen, 18

Assigning
access authorization, 32-34
application storage areas, 23-26
MARC mapping in Cataloged

Collections, 21-22
storage default locations, 24

Audit reporting, 46
Authorization

assigning access, 32-34

B

Bibliographic records
creating, 52-53
sending documents to, 49-50, 51-52,
53-54

Buttons, Quick Authorize, 34-35

C

Cataloging module
integration with ImageServer, 47

Changing
document descriptions, 25
folder access levels, 34
image filenames, 43

Checklists, post-installation, 8-9
Client setup, 6-7
Control, access, 32-34
Copying image files

See also Image files and filenames
to other folders, 42

Creating
bibliographic records, 52-53
staff user groups, 29-32

D

Data, index
editing in folders, 40

Default locations, storage
   assigning, 24
Defining

application requirements, 11-22
staff users, 27-29

Deleting
applications, 25-26
document descriptions, 25
folders, 40
images in folders, 41
staff user groups, 32
staff user profiles, 29

Document descriptions
 See also Documents
changing and deleting, 25

Documents
 See also Document descriptions
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creating new bib records for, 52-53
sending to bib records, 49-50, 51-52,

53-54
Drop-down field items, 14

 See also Fields

E

Editing
folder access levels, 33
folder index data, 40

 856 tags
moving image files within, 41

F

Fields
drop-down items, 14
and linking folders, 19-20
properties, 13

Files and filenames, image
 See Image files and filenames

Files, symtrix.ini, 5
Find Folders function, 44-45
Folder Maintenance  screen, 39
Folders

changing access levels, 33-34
copying image files to, 42
deleting, 40
deleting images in, 41
fields, 13
maintaining, 39-43
moving image files to, 41-42

Full-text OCR, 55-60
Functions, administrative

accessing, 37-38

G

Groups, staff user
 See Staff users and user groups

H

Hardware, scanning, 9

I

Image files and filenames
copying and changing, 42-43
deleting and moving, 41-42

viewing, 40
ImageServer initialization, 5-10

client setup, 6-7
post-installation checklist, 8-9
symtrix.ini file, 5

ImageServer, using, 37-60
accessing administrative functions,

37-38
audit reporting, 46
Find Folders option, 44-45
and full-text OCR, 55-60
interaction with Voyager, 47
maintaining folders, 39-43

ImageServer Maintenance, 11-36
assigning access authorization, 32-34
assigning application storage areas,

23-26
defining application requirements, 11-

22
system security setup, 27-36

Index data
editing in folders, 40

Indexes/Sorting tab, 20
.ini files, symtrix, 5
Items, field

 See also Fields
drop-down, 14

K

Keyboard shortcuts
in Cataloging module, 48

L

Levels, folder access, 32-34
 See also Folders

Locations, default storage
assigning, 24

M

Maintaining
applications, 25
folders, 39-43

Maintenance, system
 See System maintenance and

administration
Mapping, MARC

 See MARC mapping
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MARC mapping
 See also MARC tags
for OCR text, 59-60
and Sequence option, 22

MARC tags
 See also MARC mapping
sort, 22

Modifying staff user profiles, 29
 See also Staff users and user groups

Module, cataloging
 See Cataloging module

Moving image files, 41-42
 See also Image files and filenames

N

Names, application, 12
 See also Applications

New applications
 See also Applications
adding, 14-17

O

Optical Character Recognition (OCR),
full-text, 55-60

Options
Find Folders, 44-45
Sequence, 22

P

Post-installation checklists, 8-9
Properties, field, 13

 See also Fields

Q

Quick Authorize buttons, 34-35
Quality control

and Find Folders function, 44-45

R
Records, bibliographic

 See Bibliographic records
Reporting, audit, 46
Requirements, application

 See also Applications
defining, 11-22

S

Scanning hardware and software, 9
Searching WebVoyage

access levels and, 33
Security setup, system, 27-36
Sending documents

to existing bib records, 49-50
to new bib records, 53-54
to open bib records, 51-52

Sequence option
in MARC mapping, 22

Settings screens
for applications, 18

Setup
client, 6-7
system security, 27-36

Shortcuts, keyboard
in Cataloging module, 48

Software, scanner, 9
Sort tags

MARC record, 22
Staff users

defining, 27-29
deleting, 29

Staff user groups
authorizing to applications, 32
creating, 29-32
deleting, 32

Starting the OCR process, 55-59
Storage

assigning application areas, 23-26
assigning default locations, 24

Symtrix.ini file, 5
System maintenance and administration

accessing administrative functions,
37-38

assigning access authorization, 32-34
assigning application storage areas,

23-26
audit reporting, 46
defining application requirements, 11-

22
and Find Folders option, 44-45
maintaining folders, 39-43
system security setup, 27-36

System security setup, 27-36

T

Tabs, Indexes/Sorting, 20
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Tags, MARC sort, 22
 See also MARC mapping

Text verification
and full-text OCR, 58-59

U

Users and user groups, staff
See Staff users and user groups

V

Verification, text
and full-text OCR, 58-59

Viewing images, 40
 See also Image files and filenames

Voyager
interaction with ImageServer, 47

W

WebVoyage
and access levels, 33
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